
Formation QGIS 3.44

Journée 4 : Formulaires – Edition - Impression



Journée 4

• Attributs et Formulaires
• Impression 
• Edition
• Importer des photos
• Altitude

– MNT 
– Extension « Point Sampling Tool »
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Attributs et 
Formulaires

Journée 3

• Codes INS Belgique
• Modes d’affichage
• Accès aux attributs : identifier ou 

sélectionner
• Identifier par clic
• Sélectionner

– Dans zone
– Par requête

Journée 4

• Améliorer l’affichage en mode 
formulaire

• Attributs géographiques
– Lesquels ?
– Automatiser 
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Accéder aux attributs des 
objets

Méthode 1 : Identifier les attributs
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RAPPEL Journée 3
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La barre des Attributs
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Identifier les entités (objets géométriques)
Calculatrice de champs mises à jour attributs
Boîte de traitements  bibliothèque de scripts
Résumé statistique
Ouvrir la table d’attributs (de la couche courante)
Mesurer (distances, superficies, angles)
Activer info-bulle (au passage de la souris)
Actions (attribut utilisé comme paramètre)
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Identifier les entités
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QGIS propose plusieurs façons d’identifier les entités avec l’outil         

Identifier les entités. 
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Identifier les entités
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Viser une communeClic GAUCHE
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Accéder aux attributs des 
objets

Méthode 2 : Ouvrir la table des 
attributs
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RAPPEL Journée 3
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Ouvrir la table des attributs
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Barre édition Barre Filtre / sélection [1] [2]   [3]    [4]  [5]

[1] : organiser mode Tableau 
[2] : mise à jour
[3] : organiser mode Tableau 
[4] : Actions
[5] : mode intégré
[6] : Tableau  Formulaire
[7] : Filtres sur les entités
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Les données attributaires

Formation QGIS – © JM Michalowski  - IFAPME 2026

Mode formulaire intégré

Mode Formulaire

Mode formulaire flottant / intégré
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Les données attributaires
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Tri possible

Mode Tabulaire  Tableau

Mode tableau intégré
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La sélection des objets
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La barre de Sélection
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Sélection graphique des entités par « clic » ou rectangle 

Sélection graphique des entités avec un polygone

Sélection graphique des entités à main levée

Sélection graphique des entités selon un rayon

Sélection des entités par valeur

Sélection des entités à l’aide d’une expression

Sélection de toutes les entités

Inverser la sélection

Désélection de toutes les entités sélectionnées

Désélection des entités sélectionnées dans la couche courante
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Filtre d’entités
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Filtrer avec un / plusieurs critères (non-sélection)
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Les données attributaires
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Etiquette

Infobulle

Infobulle <> Etiquette
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Améliorer l’affichage des 
attributs

Niveau 1 : les outils standards
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Améliorer l’affichage des attributs
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L’affichage des attributs d’une commune est très « technique »
• Plusieurs options d’amélioration :

• Supprimer les champs inutiles  solution radicale !
• Masquer un champ (ceux trop techniques, confidentiels …) 
• Renommer les libellés
• Ajouter des nouveaux champs

• Deux onglets des
propriétés de la couche :
• Champs
• Formulaire d’attributs
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Améliorer l’affichage des attributs
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Couche « Limites Communales » > onglet « Champs »

[2][1] [3] [4] [5] [6] [7] [8] [9]

1 : Identifiant technique de la colonne
2 : Nom technique de la colonne
3 : Alias (du Nom) : à définir via l’onglet « Formulaire d’attributs » 
4 : Type de l’attribut au sens QGIS
5 : Type de l’attribut : entier, réel simple précision, réel double précision, texte, date
6 : Nombre total de caractères du champ
7 : Nombre de décimales pour un réel.
8 : Commentaire interne, non visible dans la table des attributs
9 : Réservé à la création d’un serveur WMS ou WFS
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Les champs d’un tableur lié
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Améliorer l’affichage des attributs
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Accéder à l’onglet « Formulaire » 

L’onglet « Formulaire d’attributs » vous aide à configurer le 
formulaire à afficher lors de la création de nouvelles entités ou 
de l’interrogation d’une entité existante.

– Alias : un nom lisible par l’homme à utiliser pour les champs
– Commentaire: affiche le commentaire du champ comme indiqué dans l’onglet 

Champs, en lecture seule. Ces informations sont affichées sous forme d’infobulle lors 
du survol de l’étiquette de champ dans un formulaire d’entité.

– Editable: décochez cette option pour définir le champ en lecture seule (non 
modifiable manuellement) même lorsque la couche est en mode édition. 

– Etiquette en haut : place le nom du champ au-dessus ou à côté du widget dans le 
formulaire d’entité.

– Couleurs, police … différents paramètres classiques de mise en forme
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Améliorer l’affichage des attributs
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• Onglet « Champs »  Supprimer un champ
• Passer la couche en mode Edition
• Sélectionner un ou plusieurs champs (attributs)
• Les supprimer
• Sauver les modifications

• Annuler les modifications via propriétés de la couche en 
cours de modification :  

Editions en cours > fonctions d’annulation 
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Supprimer des attributs !
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Passer en mode édition Solution radicale !
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Améliorer l’affichage des attributs
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• Onglet « Formulaire d’attributs » masquer un 
champ
• Sélectionner le champ à masquer
• Type d’outil > Caché

• Onglet « Formulaire d’attributs »  renommer un 
champ
• Sélectionner le champ à renommer
• Général > Alias (définir l’alias)

La mise en forme Formulaire n’est pas appliquée en mode Tabulaire
 autres options spécifiques au mode Tabulaire (tableau)

Mode Formulaire
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Améliorer l’affichage des attributs
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Mode Tabulaire

Sauver le projet pour conserver la disposition
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Améliorer l’affichage des attributs
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Sauver le projet pour conserver la disposition

Mode Tabulaire
« Clic bouton droit » sur une colonne
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Améliorer l’affichage des attributs
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Mode Tabulaire

La configuration du mode Tableau est sauvée dans le projet
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Calcul  d’Attributs géométriques

• Récupérer les valeurs d’attributs géométriques
– Superficie : $area 
– Longueur : $length
– Périmètre : $perimeter
– Coordonnée X : x(@geometry)

• x(transform($geometry, 'EPSG:source', 'EPSG:cible'))
• x(transform($geometry, 'EPSG:3812', 'EPSG:313170’)) : L2008  L72

– Coordonnée Y : y(@geometry)
• y(transform($geometry, 'EPSG: source', 'EPSG: cible’))
• y(transform($geometry, 'EPSG:3812', 'EPSG:4326’)) : L2008 WGS84

– Coordonnée Z : Séance 5

• Arrondir les valeurs (2 décimales)
round($Fonction,2)
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Améliorer l’affichage des 
attributs

Niveau 2 : glisser / déposer
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Améliorer affichage attributs
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Deux modes opératoires « Formulaire d’attributs » :
1. Mode « Génération automatique » (options réduites)
2. Mode par « Glisser / déposer » (options avancées)

Les deux modes permettent de :
• Masquer des champs
• Masquer des étiquettes, définir leur couleur / police 
• Retirer des champs du formulaire
• Définir des alias
• Définir des listes de valeurs permises
• Définir des contraintes …
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Améliorer affichage attributs
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« Glisser / déposer » : plus de possibilités

• Interface plus « efficace »
• Changer l’ordre des champs
• Ajouter des « Widgets » (gadgets)
• Une contrainte majeure : cliquer sur le bouton [Appliquer] 

après chaque modification (à vérifier avec version 3.44)

En personnalisant les formulaires, vous
pouvez organiser et présenter les
informations de manière claire et concise,
rendant la saisie des données plus
intuitive.
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EXERCICE 1

Modifier les champs de 
la couche “Limites 
communales” 

• Propriété “Formulaire 
d’attributs”

• Mode « Glisser / déposer »
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Améliorer l’affichage des attributs

Formation QGIS – © JM Michalowski  - IFAPME 2026

Résultat attendu

32

Couche
« Limites communales »
> onglet Formulaire



Améliorer l’affichage des attributs

Formation QGIS – © JM Michalowski  - IFAPME 2026

Conception par glisser / déposer
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Améliorer l’affichage des attributs

Formation QGIS – © JM Michalowski  - IFAPME 2026

Retirer tous les champs du formulaire
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Améliorer l’affichage des attributs
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Sélection des champs du formulaire par glisser / déposer
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Améliorer l’affichage des attributs
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Masquer l’étiquette du nom de la commune
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Améliorer l’affichage des attributs
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Définir un alias (affiché à la place du nom du champ)
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Répéter l’opération pour tous les champs administratifs

AdMuKey : commune
AdDiKey : arrondissement
AdPrKey : province
AdReKey : région



Améliorer l’affichage des attributs

Les « Widgets »

• Insérer une ligne horizontale 
• Insérer un texte simple (commentaire, note …)
• Insérer le contenu d’un champ, mais en imposant un 

formatage
• Insérer une photo (formation avancée : HTML + javascript)
• Personnaliser les formulaires (format .ui - langage QML)
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Améliorer l’affichage des attributs
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« Spacer Widget »  Insérer une ligne
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Faire glisser



Améliorer l’affichage des attributs
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« Spacer Text »  Insérer un commentaire
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Faire glisser



Améliorer l’affichage des attributs
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« Spacer Text »  Imposer un formatage à la valeur d’un champ

round("Shape_Area" /10000,2)  || ' Ha'
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Améliorer l’affichage des attributs
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Résultat attendu

['Hommes : ' || (round("Statbel 2025 
Hommes" / "Statbel 2025 Total" ,2) * 100) || 
'%’  
||  '\n'  || 
'Femmes : ' || (round("Statbel 2025 Femmes" 
/ "Statbel 2025 Total" ,2) * 100) || '%'%]
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Améliorer l’affichage des attributs
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[% 'Hommes : ' || (round("Statbel 2025 Hommes" / "Statbel
2025 Total" ,2) * 100) || '%'  
||  '\n'  || 
'Femmes : ' || (round("Statbel 2025 Femmes" / "Statbel 2025 
Total" ,2) * 100) || '%’ %]

• [% … %] : formatage de la formule
• "Nom d’un champ" (depuis la liste des champs de la couche)

• 'Libellé' 
• || : opérateur de concaténation
• '\n' : saut à la ligne (<br> si ne fonctionne pas)
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Formulaire – lien vers la photo

Couche « BI Tournai (OSM) » > Propriétés > Formulaire > 
champ « Photo » (nom de la photo)
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Adapter !

Stocker les photos sur un disque dur partagé 44



Formulaire – lien vers la photo
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[Appliquer] – [OK]
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Formulaire – lien vers la photo
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Couche « BI Tournai (OSM) » > Zoom sur la couche
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Améliorer l’affichage des 
attributs

Niveau 3 : niveau expert : format .ui
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Améliorer l’affichage des attributs
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Réalisé en 4 itérations grâce à l’IA !
1. Définir la liste des champs à utiliser
2. Définir le format : 2 panneaux
3. Définir la répartition par colonne
4. Définir les couleurs, police …
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Impressions

• Exporter format Image
– Décorations de la carte
– « Imprimer » 

• Mises en page
– Eléments de base

• Carte
• Echelle Nord
• Barre d’échelle
• Légende
• Simplifier la légende

– Autres éléments
– Imprimer
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Impression

Niveau 1 : exporter une image
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EXERCICE 1

Exporter une image

• Décorations de la carte

• Menu Projet > Importer / 
exporter > Exporter la carte 
au format Image

• Copier vers le presse-papiers

Exercice à réaliser avec le projet 
en cours
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Décorations de la carte
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menu Vue  Décorations

• Grille == graticulage
• Barre échelle
• Image
• Flèche Nord
• Etiquette de titre
• Etiquette de ©
• (Emprises des mises en page)
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Décorations de la carte : Grille
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Décorations de la carte : barre échelle
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Décoration de la carte : Flèche Nord
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Décoration de la carte : Titre
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Décoration de la carte : ©
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© SIGEFOR - 2026 

57



Décoration de la carte : emprise mises en page
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Impression

Niveau 2 : la mise en page
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Mise en page

La mise en page doit suivre une construction rigoureuse basée
sur les principes de Sélection (choix de format, données à
afficher...), schématisation (que faire apparaitre, comment
mettre en avant le message, charte graphique, …),
harmonisation (cela doit être agréable à l’œil ).
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Mise en page

La mise en page de carte fournit des fonctionnalités de mise en
page et d’impression. Elle vous permet d’ajouter des éléments tels
que :

– le canevas de carte (un ou plusieurs), 
– des zones de textes (titres, ©, …), 
– des images (logos …), 
– des légendes, 
– des échelles graphiques, 
– des formes de base, 
– des flèches, 
– des tables attributaires,
– des cadres où insérer du code HTML ( accès à une ULR par exemple)

Tous les outils du composeur de cartes sont disponibles dans les
menus et les barres d’outils. Ces barres peuvent être affichées ou
masquées en faisant un clic droit dessus.
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Mise en page

Points d’attention :
• Avant de démarrer la mise en page, vous devez charger des 

couches raster et/ou vecteurs dans la fenêtre principale de 
QGIS et adapter leurs propriétés (échelle de visibilité, ordre 
d’affichage, taille et couleur des symboles et étiquettes …) 
pour qu’elles vous conviennent. 

• Quand tout est rendu et symbolisé comme souhaité, vous 
pouvez commencer la mise en page.
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Mise en page

Points d’attention :
• Si l’affichage est trop lent dans la mise en page, décocher les 

couches RASTER, WMS …
• Pour un usage public, si vous imprimer le fond de carte de 

l’IGN, n’oubliez pas d’ajouter dans une zone de texte, la 
mention suivante, en l’adaptant avec votre numéro de 
convention (http://cartoweb.be) :
« Extraits de CartoWeb.be avec l'autorisation de L'institut géographique 

national <<VotreConvention>>- www.ign.be » 
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Le Gestionnaire de mises en page
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Afficher la sélection : vous pouvez sélectionner
plusieurs rapports et / ou imprimer des mises en
page et les ouvrir en un seul clic. Double-cliquez
sur un nom pour l’ouvrir ;
Dupliquer la mise en page ou le rapport
sélectionné (disponible uniquement si un élément
est sélectionné) : cela ouvre une nouvelle fenêtre
utilisant l’élément sélectionné comme modèle. Le
gestionnaire vous demandera de choisir un
nouveau titre pour la nouvelle mise en page ;
Renommer la mise en page ou le rapport
(disponible uniquement si un élément est
sélectionné) : le gestionnaire vous demandera de
choisir un nouveau titre pour la mise en page ;
Supprimer la mise en page : la ou les mises en
page seront supprimées du projet.
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Le Gestionnaire de mises en page
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Création de nouvelles mises en page

• A partir de modèles stockés sous :
• Le répertoire défini dans le profil de l’utilisateur
• Dans le répertoire QGIS des modèles
• Dans tout autre répertoire défini via 

Préférences ‣ Options ‣ Mise en page
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Le Gestionnaire de mises en page

Les onglets

• Le panneau Mise en page vous permet de définir les 
paramètres généraux à appliquer à la mise en page lors de 
l’exportation ou du travail ;

• Le panneau Éléments fournit la liste de tous les objets de la 
mise en page ajoutés au canevas et des façons 
d’interagir(verrouillage) globalement avec eux.

• Le panneau Historique affiche l’historique de toutes les 
modifications appliquées à la mise en page. D’un simple 
clic de souris, il est possible d’annuler et de refaire les 
étapes de mise en page jusqu’à un certain état ;
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Le Gestionnaire de mises en page

Les onglets

• Le panneau Propriétés de l’objet affiche les propriétés 
pour l’objet sélectionné sur la mise en page;

• Le panneau Guides permet de définir des guides 
d’accrochage horizontaux et verticaux (qui forment 
une grille) afin de positionner très précisément les 
objets posés sur le canevas de la mise en page, et de 
définir les marges physiques de votre imprimante.
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Créer une nouvelle mise en page

Deux méthodes pour créer une nouvelle mise en 
page
• Créer directement :                                  ou CTRL-P
• Accéder au Gestionnaire de mise en page > [Créer]
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Valider [OK]
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EXERCICE 2

Imprimer via une mise 
en page

• Créer une mise en page

• Ajouter les 4 objets 
élémentaires

• Autres objets de mise en 
page

• Imprimer 
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Créer une nouvelle mise en page
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Ctrl-P

70

Charger le projet ../jour4/Data/Jour4-01



Créer une nouvelle mise en page
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Créer une nouvelle mise en page

Les guides
• Permettent de définir la zone

réellement imprimable, en
tenant compte des marges
physiques de l’imprimante
(notion de marges
d’impression)

Formation QGIS – © JM Michalowski  - IFAPME 2026 72



Créer une nouvelle mise en page
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Bordure de 5 mm tout autour de la page
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Les objets élémentaires

4 objets élémentaires pour une impression conforme

• La carte
– Zone rectangulaire dans laquelle s’affiche la carte QGIS

• L’échelle
– Barre d’échelle ou échelle numérique

• La flèche Nord
– Insertion d’une image représentant une flèche Nord. Rotation Ok

• La légende
– Insertion d’un cartouche de légende, peut être complexe, envisager de le 

simplifier. Etape qui peut demander du temps

Formation QGIS – © JM Michalowski  - IFAPME 2026 74



Les objets élémentaires : la carte
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Accrocher la carte sur les guides
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Les objets élémentaires : la carte
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Cadrage courant dans la mise en page
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Les objets élémentaires : la carte
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Propriétés principales

Echelle : Echelle de tracé de la mise en page
Rotation de la carte : avec suivi de la Flèche Nord 
SCR : Choix du SCR de tracé ;

Dessiner les objets du canevas de carte : 
Afficher dans la mise en page les annotations de 
la carte principale.

Par défaut, l’apparence de l’objet carte est synchronisée
avec le rendu du canevas de la carte, ce qui signifie que
le basculement de la visibilité des couches ou la
modification de leur style dans le Panneau couches est
automatiquement appliqué à l’objet Carte (de la mise
en page).
Verrouiller les couches (et les styles) permet de
conserver le contenu cartographique de votre
mise en page.

77



Les objets élémentaires : l’échelle

Les barres d’échelle fournissent une indication visuelle de la
taille et de la distance entre les entités représentées sur la
carte.
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Les styles de barre d’échelle

Carte : carte à laquelle la barre d’échelle 
sera associée
Style : 8 styles de représentation de la 
barre d’échelle
choisir « Numérique » pour afficher une 
échelle numérique
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Les objets élémentaires : l’échelle
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Unités de la barre d’échelle : sélectionner les unités à 
utiliser. 
Multiplicateur des unités de l’étiquette : indique le nombre 
d’unités de la barre d’échelle par unités étiquetées.

« mètres » -> multiplicateur 1000 -> « kilomètres ».
Etiquette pour les unités : permet de définir le texte à 
utiliser pour étiqueter les unités de la barre d’échelles.
Format de Nombre : Personnaliser les options de la légende 
numérique

Segments : Définir le nombre de segments à Gauche et à 
Droite du zéro de la barre d’échelle
Largeur fixe : largeur des segments fixes
Largeur ajustée au segment : à chaque fois que l’échelle 
de la carte est modifiée, la barre d’échelle est 
redimensionnée (et les étiquettes modifiées) pour 
s’adapter à l’intervalle.
Hauteur : hauteur des barres.

Gauche 0 et Droite 4 Gauche 2 et Droite 4
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Les objets élémentaires : l’échelle
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Les objets élémentaires : la flèche Nord
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• La Flèche Nord est liée à une carte (carte de référence par 
défaut)

• Un fichier SVG est associé automatiquement à la création de 
la flèche Nord; il provient de la bibliothèque SVG de QGIS

Mode de redimensionnement : définir comment l’image 
est affichée lorsque le cadre de l’objet Image est modifié.
• Zoom
• Etirer
• Découper
• Zoom et redimensionner le cadre
• Redimensionner le cadre à la taille de l’image
Position : sélectionner la position de l’image à l’intérieur 
du cadre de l’objet Image
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Les objets élémentaires : la flèche Nord
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Les objets élémentaires : la légende

La Légende à imprimer

L’objet le plus complexe à paramétrer

Trouver le bon équilibre entre la visibilité de la légende (à l’impression !) et le
nombre d’éléments présents dans la légende.

Comment faire ?

• Ne pas multiplier les thématiques à imprimer sur une seule carte
• Choisir des symbologies nettes et bien distinctes à l’impression

– Éviter par exemple, 10 représentations dans une même gamme de
couleurs

• Prendre le temps de tester à l’impression (pdf + papier) les symbologies
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Les objets élémentaires : la légende
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Les objets élémentaires : la légende
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Eléments de la légende
La fenêtre des éléments de légende répertorie tous les
éléments de la légende et vous permet de changer
l’ordre des éléments, de grouper les couches, de
supprimer ou de restaurer des éléments de la liste, de
modifier les noms des couches et d’ajouter un filtre.

Propriétés principales
Titre : Modifier le titre de la légende
Carte : Choisir la carte qui sera décrite par la légende (utile en 
cas de multi-cartes)
Activer le retour à la ligne après : Définir un caractère qui 
permet l’insertion des retours à la ligne
Disposition : Définir la position des symboles et du texte dans la 
légende (gauche ou droite)

Ajuster au contenu : 
1. Contrôle si la légende doit être redimensionnée 

automatiquement pour s’ajuster au contenu ou pas.
2. Si elle est décochée, la légende ne sera pas redimensionnée 

et gardera la taille définie par l’utilisateur. Le contenu qui 
dépasse sera coupé.
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Les objets élémentaires : la légende
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Mise à jour auto
La légende sera automatiquement mise à jour si  
Mise à jour auto est cochée. Si cette option n’est 
pas cochée, cela vous donnera plus de contrôle sur 
les éléments de la légende. Tous les boutons situés 
sous la liste des éléments de la légende seront 
activés.
[Tout mettre à jour] : mise à jour de la légende 
après modification de la symbologie dans la carte

Ne montrer que les entités à l’intérieur de la 
carte liée
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Les objets élémentaires : la légende
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En décochant « Mise à jour auto » et en cochant « Ne montrer que les entités
liées à la carte, la légende s’allège considérablement
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Les objets élémentaires : la légende
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Simplifier la légende à imprimer : retirer les couches inutiles
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Les objets élémentaires : la légende
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Simplifier la légende à imprimer :  masquer des titres
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Mise en page
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Mise en page
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Les objets élémentaires : la légende
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Simplifier la légende à imprimer :  ajouter des éléments de légende

• Revenir dans la fenêtre carto de QGIS
• Ouvrir le signet « Mairie de Grivegnée »

Revenir à la mise en page 
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Les objets élémentaires : la légende
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Simplifier la légende à imprimer :  ajouter des éléments de légende

93



Les objets élémentaires : la légende
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Simplifier la légende à imprimer :  adapter les libellés
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Les objets élémentaires : la légende
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Simplifier la légende à imprimer :  agencement en colonnes
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Les objets élémentaires : la légende
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Simplifier la légende à imprimer :  agencement en colonnes
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Les objets élémentaires : la légende

Formatage texte
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Autres options
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Autres objets de mise en page

L’objet IMAGE
• Insertion d’une image : fichier image ou fichier SVG  logos

– Taille et position / Rotation
– Dimensions
– Cadre et arrière-plan

L’objet FORME
• Insertion d’une forme vectorielle

– Rectangle – Ellipse – triangle 
– Taille et position / Rotation

L’objet SYMBOLE
• Insertion d’un symbole de la bibliothèque

– Taille et position / Rotation
– Arrière-plan
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Autres objets de mise en page
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Autres objets de mise en page

L’objet Etiquette
• Les objets de type Étiquette vous permettent d’ajouter du 

texte à vos cartes et d’améliorer leur compréhension ; il 
peut s’agir du titre, de l’auteur, des sources des données ou 
tout autres informations … 
– Contenu de l’étiquette : texte ou HTML
– Police / Couleurs du texte
– Taille et position / Rotation
– Dimensions
– Cadre et arrière-plan
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Autres objets de mise en page - Etiquette
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Autres objets de mise en page

La table Attributaire
• Toute couche du projet peut voir ses attributs affichés dans 

la mise en page. 
• Par défaut, un nouvel objet table d’attributs charge les 

premières lignes de la première couche (triée 
alphabétiquement), avec tous les champs. Vous pouvez 
cependant personnaliser le tableau grâce aux différentes 
propriétés, principales et d’affichage. 

Ajouter une page à la mise en page courante
• Insérer une table attributaire
• Insérer une autre carte
• Etc.
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Autres objets de mise en page – La table attributaire
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Imprimer la mise en page
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Numérisation 
vectorielle
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Numérisation vectorielle
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Avant de commencer …

1. Réflexion (partagée) sur la modélisation de la 
couche à créer

2. Un type de géométrie (Point/Ligne/Polygone) par 
couche

3. Les objets géométriques ont des attributs
– Un champ identifiant unique (de préférence 

numérique  « fid » automatique du .GPKG)
– Des champs attributaires

• Liste de valeurs, contraintes, NULL autorisé ?, …

Information

103



Numérisation vectorielle
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QGIS n’est pas un logiciel de dessin, mais …

1. Il propose des outils de dessin de base, complétés par
de nombreuses extensions (parfois très spécifiques)

2. L’import de fichiers type « autocad » est possible
3. Des données peuvent être créés depuis des adresses

postales (geocodage), des traces GPS, …
4. Bien évaluer les ressources et compétences en interne,
 sous-traiter à un bureau de dessin ?

5. Des améliorations / simplification sont annoncées avec
QGIS 4.0 !

Information
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Numérisation vectorielle
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Définir la précision de numérisation : 2 notions

1. Tolérance d’accrochage
– C’est la distance que QGIS utilise pour chercher le 

sommet et / ou le segment (ligne) le plus près que vous 
souhaitez connecter lorsque vous créez un nouveau 
sommet ou en déplacez un existant

– La valeur de la tolérance d’accrochage est utilisée en 
CREATION de géométries.

Précision de numérisation
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Numérisation vectorielle
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Définir la précision de numérisation : 2 notions

2. Rayon de recherche
– Le rayon de recherche est la distance que QGIS utilise pour 

chercher le sommet le plus proche que vous souhaitez 
déplacer quand vous cliquez sur la carte. 

– La valeur du rayon de recherche est utilisée en 
DEPLACEMENT de géométries.

Précision de numérisation
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Numérisation vectorielle
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Précision de numérisation

menu > Préférences > Options > Numérisation
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Numérisation vectorielle
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Précision de numérisation

Projet > Options d’accrochage

Barre outils Accrochage
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Numérisation vectorielle
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Intégrité des données
Il est toujours bon de sauvegarder vos données sources avant de 
les éditer. Bien que les auteurs de QGIS aient fait tous les efforts 
possibles pour préserver l’intégrité de vos données, il n’y pas de 
garantie à cet égard.

Sauvegarde des données
Quand une couche est en mode édition, tous les changements
sont stockés en mémoire par QGIS. Ils ne sont pas sauvegardés
immédiatement dans la source de données ou sur le disque.
Si vous voulez enregistrer les modifications sans quitter le mode
d’édition, il faut cliquer sur le bouton

Recommandations
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Numérisation vectorielle
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Les aides à la saisie des attributs

1. Les listes de valeurs  légende catégorisée
2. Les valeurs par défaut

• Valeur numérique ou chaine de caractères
• Attributs géométriques : $area, $length, …
• Expression « Overlay_intersects »

3. Plage de valeurs autorisées (+ barre coulissante)
4. Calendrier pour les champs de type DATE

• Date du jour : expression « now() »

5. Stratégies lors de la duplication ou de la séparation d’une 
entité

Aides à la saisie des attributs
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Aides à la saisie des attributs : Liste de valeurs

Couche : « Arbres isolés »
Champ : Espèce
Outil : Liste de valeurs
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Numérisation vectorielle
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Aides à la saisie des attributs : Liste de valeurs

Couche : «Voirie»
Champ : DateEntretien
Défauts : Date du jour : now()
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Numérisation vectorielle
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Aides à la saisie des attributs : valeur par défaut

Couche : « Arbres isolés »
Champ : Etat
Défauts : 1  Sain

Couche : « Arbres isolés »
Champ : Parcelle
Défauts : « Overlays_intersects »
• Récupération du numéro de

gestion depuis la couche 
« Parcelles »
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Aides à la saisie des attributs : valeur par défaut

Couche : « Parcelles »
Champ : Superficie
Défauts : round($area,2)

Couche : « Voirie »
Champ : longueur
Défauts : round($length,0)
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Numérisation vectorielle
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Barre d’accrochage

Édition topologique : aide à éditer et à conserver des limites communes entre 
entités.
Gestion du chevauchement

Activer l’accrochage aux intersections

Tracé automatique : créer très rapidement des polygones sur base de lignes 
fermées
Auto-accrochage 

Aide complète numérisation – version 3.34
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Outils de la barre de numérisation de base
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EXERCICE 3

Numérisation vectorielle

• Créer des ponctuels

• Créer des linéaires

Form
ation Q

G
IS –
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E 2026
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Outils de base
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Charger le projet ../Jour4/Data/Parcellaire forestier
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Liste de valeurs
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Couche « Arbres isolés » > Propriétés > Formulaire d’attributs

Charger le fichier ../Jour4/Data/ListeEspeces.csv
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Liste de valeurs
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Création d’un ponctuel « Arbres isolés »
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Couche « Arbres isolés »

121



Création d’un linéaire « Voirie »
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Accrochage

Couche « Voiries »
Série de « Clics gauche » pour numériser
« Clic droit » pour clôturer 
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Création d’un linéaire « Voirie »
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Série de « Clics gauche » pour numériser
« Clic droit » pour clôturer 
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EXERCICE 4

Numérisation vectorielle

• Créer des polygones : option 
trace automatique

Form
ation Q

G
IS –
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E 2026
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Création d’un polygone « Coupes » - Auto- Tracé
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Le mode de traçage automatique, accélère le processus de
numérisation car vous n’avez plus besoin de placer
manuellement tous les sommets pendant la numérisation

Accrochez-vous à un sommet ou un segment d’une entité que
vous souhaitez tracer.

Déplacez la souris sur un autre sommet ou segment que vous
souhaitez accrocher, l’élastique de numérisation représente un
chemin entre le dernier point que vous avez accroché et la
position actuelle.
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Objectif : ajouter des polygones à la couche « Coupes »

Etape 1 : définir les options d’accrochage
Etape 2 : tracer la limite du polygone
Etape 3 : « Clic droit » pour terminer le polygone

Cocher les couches sur lesquelles
vont s’appuyer les limites des
polygones à ajouter

Création d’un polygone « Coupes » - Auto- Tracé
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Création d’un polygone « Coupes » - Auto- Tracé
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Création d’un polygone « Coupes » - Auto- Tracé
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EXERCICE 5

Numérisation vectorielle

• Créer des polygones : Ajouter 
un anneau

Form
ation Q

G
IS –
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Création d’un polygone troué : ajout d’un anneau
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La création/suppression d’anneaux nécessite l’activation 
de la barre d’outils « numérisation avancée »

Etape 1 : activer la commande « Ajouter un anneau »
Etape 2 : désigner le polygone à trouer
Etape 3 : dessiner l’anneau
Etape 4 : « Clic droit » pour fermer l’anneau et trouer le polygone
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Création d’un polygone troué : ajout d’un anneau
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Création d’un polygone troué : ajout d’un anneau
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Importer 
des photos 
géolocalisés

• Extension ImportPhotos
• Importer les photos

– Créer une couche de 
points en WG84 (Lat/Long)

– Création GPKG dédicacé

• Naviguer
– Info-bulles sur points
– Table des attributs
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Installer l’extension ImportPhotos
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Charger le projet ../Jour4/Data/Territoires



Quelles photos ?
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• Les photos doivent être géolocalisées, c’est-à-dire 
avoir été prises avec le GPS activé;

• Elles seront stockées dans un répertoire dont le 
chemin d’accès ne comporte pas d’espace;

• La couche de points (SCR : WGS 84) créée sera 
stockée dans un géopackage (.gpkg);

• Photos sous ../Jour4/Data/Photos_BI_Tournai
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L’import des photos

Formation QGIS – © JM Michalowski  - IFAPME 2026

Exécuter l’extension « ImportPhotos »

Définir le répertoire « Input » où sont localisées les photos
Définir la localisation et le nom du géopackage de stockage des points
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Le résultat (sur fond IGN)
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Ordre des couches > Couche Photos au dessus
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Navigation dans les photos
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« Click Photos »
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XYZ et MNT

• XYZ et MNT
– Les sources de données
– Géoportail wallon
– SRTM « NASA »
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Les sources de données du Z
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Au moins 6 sources de données

Les sources « illustratives » 

1. La carte IGN 
– Courbes de niveau et sommets sont visibles au 5000e

2. Les traces GPX
– Points avec coordonnées XYZ

3. Les « points photos » 
– Points avec coordonnées XYZ
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Les sources de données du Z
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Au moins 5 sources de données

Les sources « informatives »

4. Les couches « Courbes de niveau » (Open Data Wal-BXL)
5. Les modèles numériques (MNT / MNS) du Géoportail
6. Le SRTM 

– Shuttle Radar Topography Mission – © NASA
– Résolution de 30 m – couverture mondiale !
– MNE (DEM)
– Télécharge directement dans QGIS via une extension !
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Les sources de données du Z
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Sommet
Courbe

Carte IGN au 5000e
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Les sources de données du Z

Formation QGIS – © JM Michalowski  - IFAPME 2026

Les Modèles Numériques
Il existe trois types de modèles numériques couramment utilisés en 
géomatique : MNT, MNE et MNS.

1. MNT (Modèle Numérique de Terrain)
Représente la surface terrestre nue en 3D, sans aucune végétation, 
bâtiment ou autre structure.

2. MNE (Modèle Numérique d'Élévation)
Similaire au MNT, il représente la surface terrestre nue. Cependant, 
le terme MNE est souvent utilisé de manière plus générale pour inclure 
différents types de modèles numériques représentant l'élévation 
(exemple : MNE « Canopée » : mesure la hauteur de la canopée des forêts).

3. MNS (Modèle Numérique de Surface)
Description : Représente la surface terrestre avec toutes les 
structures présentes, incluant la végétation, les bâtiments et les 
infrastructures.
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Les sources de données du Z
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Les sources de données du Z
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Vue en estompage de pente (hillshade) du Modèle
Numérique de Terrain (MNT) de la Wallonie issue d’une
acquisition par LIDAR. Il en existe 2 versions :

1. Version 2013 – 2014
• Résolution d’un mètre
• MNT ou MNS

2. Version 2021 – 2022
• Résolution de 50 cm
• MNT ou MNS

Géoportail – MNT « HillShide »
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Les sources de données du Z
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Géoportail – MNT « HillShide »

menu Raster > Extraction > 
Découper un raster selon une 

image de masque
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Les sources de données du Z
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1. Création d’un compte « OpenTopography »
– https://portal.opentopography.org/newUser?lang=fr
– Créer un nouveau compte 
– Réception d’un mail de confirmation  Connexion
– « My account »  API Key  Copier

2. Installer l’extension « SRTM-Downloader »
– menu Extension > Installer / Gérer les extensions

« SRTM »
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Les sources de données du Z

Formation QGIS – © JM Michalowski  - IFAPME 2026

« SRTM »
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EXERCICE 6

Geoportail Wallon 

• MNT « Hillshade »
• Définir le style

Form
ation Q
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Les sources de données du Z
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1. Sélectionner le groupe « RASTER »
2. Ajouter le fichier « RELIEF_WALLONIE_MNT_2013_2014_HILLSHADE.tif » 

localisé sous « ../Jour4/Data/Raster/MNT RW Liege »
3. Ordre des couches : MNT au dessus des couches IGN
4. Propriétés > Symbologie > Type de Rendu

• Bande grise unique
• Dégradé de couleur : Noir vers Blanc
• Min : 0 – Max : 255 (altitudes)

5. Sélectionner la couche > Zoom sur la couche

Géoportail – MNT « HillShide »
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Les sources de données du Z
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Géoportail – MNT « HillShide »
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Les sources de données du Z
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Géoportail – MNT « HillShide »
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EXERCICE 7

SRTM

• Télécharger tuile « SRTM »

• Découper une tuile aux 
limites d’un polygone

• Comparer SRMT et HillShade

Form
ation Q
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Les sources de données du Z
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1. Masquer la couche «RELIEF_WALLONIE_MNT_2013_2014_HILLSHADE.tif » 

2. Activer l’extension « SRTM-downloader »

Coordonnées en fonction
du cadrage courant

Adapter le chemin de sortie
vers ../Jour4/Data/RASTER

« SRTM »
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Les sources de données du Z
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1. Zoom sur l’image chargée Image « SRTMGL1_E.tiff » sous 
../jour4/Data/RASTER/SRTM

« SRTM »
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Les sources de données du Z
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3. menu Raster  > Extraction > Découper un raster 
selon une image de masque

« SRTM »
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« SRTM » « RW HillShade »

« SRTM » versus « Hillshade »
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EXERCICE 8
Courbes de niveau

• Générer depuis MNT

• Symbologie - Etiquettes

Form
ation Q

G
IS –
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menu Raster  > Extraction > Courbes de niveau

Le nombre de lignes « courbe de niveau » générées est 
lié à la résolution du MNT
– SRMT : 30 m
– MNT « HillShade » : 

1 m ou 0,50 m

Courbes de niveau

Des heures de calcul
4.000.000 lignes !
Inutilisable …
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Courbes de niveau

Intervalle entre les courbes

Attribut « Altitude »

Depuis le SRTM découpé
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Etiquettes Courbes de niveau
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Style Courbes de niveau  lignes épaisses pour les centaines de mètres

Explication :

• tostring(« ELEV") : Convertit la valeur 
entière du champ en chaîne de 
caractères.

• right( ..., 2) : Extrait les deux derniers 
caractères de la chaîne.

• = '00' : Vérifie si les deux derniers 
caractères sont '00'.

right( tostring(« ELEV"), 2) = '00'
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EXERCICE 9 Coloriser un MNT
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Coloriser le MNT

Couche « Découpé » > Propriétés > Symbologie

Clic droit >  Palette « Spectral »
Inverser la palette de couleurs
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EXERCICE 10

Extension « Point 
Sampling Tool »

• Définir coordonnée Z d’objets 
ponctuels

• Afficher infobulle avec 
l’altitude

Form
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Ajouter extension « Point Sampling Tool »

Attribuer Z aux points
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Utilisation de « Point Sampling Tool »

1. Ne permet d’assigner une valeur Z qu’à une couche 
de points visible lors de l’exécution du plugin;

2. Le type géométrique doit être Point; MultiPoint est 
toléré si tous les points sont uniques;

3. La couche de points et le MNT doivent être dans le 
même SCR;

4. Le fichier de sortie est un fichier .GPKG qui peut 
exister; une couche y est créée et ajoutée dans le 
projet courant.

Attribuer Z aux points
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Attribuer Z aux points

Si les couches à utiliser sont dans un SCR différent, ce message est affiché

La couche  temporaire « Découpé » (MNT Géoportail) doit être exportée dans le 
même SCR que la couche des arrêts de bus (EPSG 3812 – Lambert 2018)
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Attribuer Z aux points

Couche « Découpé » [Géoportail]
> Exporter > Enregistrer sous …

169



Les sources de données du Z

Formation QGIS – © JM Michalowski  - IFAPME 2026

Assigner une altitude aux arrêts TEC
1. Ouvrir le signet « Liège Guillemins »  Arrêts TEC visibles
2. Exécuter « Point Sampling Tool »

Attribuer Z aux points

Arrêts de bus

MNT « Découpé »  la couche doit être visible

Nom de l’attribut Z

ALTITUDE
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Attribuer Z aux points
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Etape 1 : copier le style depuis la couche « Poteaux TEC »

Etape 2 : coller le style vers la couche « TEC_Z »
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Configurer une info-bulle sur la couche créée

Attribuer Z aux points

round("ALTITUDE",0) || ' m'
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Arrêts TEC  2 couches
1. « Arrêts de bus » : localisation des poteaux TEC + infos
2. « TEC_Z » : l’altitude des poteaux

Pour « fusionner » les 2 couches, 2 méthodes :
1. Intersection entre les  2 couches  crée une 3e couche
2. Mise à jour via une requête spatiale   voir Jour 5

Pour information
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